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Chapter 1 — Exploring the Network
1.0.1.2 Class Activity — Draw Your Concept of the Internet 

Instructor Note: Red font color indicates text that appears in the instructor copy only.

Objectives

Networks are made of many different components

In this activity, you will visualize how you are connected, through the Internet, to those places, people, or 
businesses with whom (or which) you interact on a daily basis. After refl ection and sketching your home’s or 
school’s topology, you can draw conclusions about the Internet that you may not have thought of prior to this 
activity.

Background / Scenario

Draw and label a map of the Internet as you interpret it now.  Include your home or school/university location 
and its respective cabling, equipment, devices, etc.  Some items you may want to include:  

• Devices or equipment     

• Media (cabling)    

• Link addresses or names    

• Sources and destinations     

• Internet service providers

Upon completion, save your work in a hard-copy format, it will be used for future reference at the end of this 
chapter.  If it is an electronic document, save it to a server location provided by your instructor. Be prepared to 
share and explain your work in class.

For an example to get you started, please visit:  http://www.kk.org/internet-mapping

Instructor Note: This Modeling Activity is not intended to be a graded assignment.  Its purpose is to help 
students to refl ect on their perceptions of how a network is set up for personal use.  Discussion should be 
facilitated by the instructor as a result of this activity.  Facilitation of the discussion should include student-to-
student discussions of each other’s work.

Required Resources
• Internet access

• Paper and pencils or pens (if students are creating a hard copy)

Refl ection

1. After reviewing your classmates drawings, were there computer devices that you could have included on your 
diagram? If so, which ones and why? 

_______________________________________________________________________________________

Answers will vary.
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2. After reviewing your classmates’ drawings, how were some of the model designs the same or different?   
What modifi cations would you make to your drawing after reviewing the other drawings?

_______________________________________________________________________________________

Answers will vary.

3. In what way could icons on a network drawing provide a streamlined thought process and facilitate your 
learning? Explain your answer.

_______________________________________________________________________________________

Students should note that having a set of representative icons will assist them in learning how to draw/design 
network representation. It consolidates information, and is easily understood by others who understand what 
the icons represent. It is a form of shorthand for people in the same industry.

Initial Network Diagrams and Network Components – will vary.  A very basic network design representation from 
the website is depicted below (this diagram is for Instructor reference.)
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1.1.1.8 Lab — Researching Network Collaboration Tools 

Instructor Note: Red font color indicates text that appears in the instructor copy only.

Objectives

Part 1: Use Collaboration Tools

• Identify current awareness of collaboration tools.

• Identify key reasons for using collaboration tools.

Part 2: Share Documents with Google Drive

Part 3: Explore Conferencing and Web Meetings

Part 4: Create Wiki Pages

Background / Scenario

Network collaboration tools give people the opportunity to work together effi ciently and productively without 
the constraints of location or time zone. Collaborative tool types include document sharing, web meetings, 
and wikis.

In Part 1, you will identify collaboration tools that you currently use. You will also research some popular col-
laborative tools used today. In Part 2, you will work with Google Drive. In Part 3, you will investigate Confer-
encing and Web meeting tools and, in Part 4, you will work with wikis.

Instructor Note: This lab may be assigned as homework.

Required Resources

Device with Internet access

Part 1: Use Collaboration Tools

Step 1: List some collaboration tools that you currently use today.

____________________________________________________________________________________

____________________________________________________________________________________

Answers will vary but could include: Google Drive, Cisco Webex, Citrix Go to Meeting, Confl uence Wiki.

Step 2: List some reasons for using collaboration tools.

____________________________________________________________________________________

____________________________________________________________________________________

Answers will vary but could include: centralization, less email, reduced travel and less environmental 
impact.
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Part 2: Share Documents with Google Drive
In Part 2, you will explore the document sharing functions by using Google Drive to set up document sharing. 
Google Drive, formally Google Docs, is a web-based offi ce suite and data storage service that allows users 
to create and edit documents online while collaborating in real-time with other users. Google Drive provides 5 
GB of storage with every free Google account. You can purchase additional storage, if needed.

Step 1: Create a Google account.
To use any of Google’s services, you must fi rst create a Google account. This account can be used with any 
of Google’s services, including Gmail.

a. Browse to www.google.com and click Sign in (located at the top-right corner of the web page).

b. On the Google Accounts web page, if you already have a Google account, you can sign in now; other-
wise, click SIGN UP.

c. On the Create a new Google Account web page, fi ll out the form to the right. The name you enter in the 
Choose your username fi eld becomes the account name. It is not necessary to supply your mobile 
phone or current email address. You must agree to the Google Terms of Service and Privacy Policy be-
fore clicking Next step.
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d. The next web page allows you to add a profi le photo if you would like. Click Next Step to complete the 
account creation process.

Step 2: Create a new document.

a. Sign in to Google using the access credentials you created in Step 1. Type http://drive.google.com in 
your browser and press Enter. This navigates you to Google Drive.

b. Click the CREATE button to display a drop-down menu that allows you to select the type of document to 
create. Choose Document.
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The new document displays. Many of the functions of the Google editor work similarly to Microsoft Word.

Step 3: Share a Google document.
a. After the blank Google document opens, you can share it with others by clicking the Share button (at the 

top-right corner of the web page).

b. Name your new document, then click the Save button.

c. Here on the Sharing settings web page, in the Add people text fi eld, you can enter Google email names, 
email addresses, or groups with whom to share this document.
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d. As soon as you start entering information into the Add people box, the box provides more options. The 
Can edit drop-down menu allows you to choose the document privileges (Can edit, Can comment, Can 
view) for the people you add. You can also specify how to notify these people of this document (Send a 
copy to myself or Paste the item itself into the email). Click Share & save.

e. Click the Done button. This will navigate you back to the open document.

f. All users with share privileges can view this document at the same time. Users with edit privileges can 
edit this document while others view it.

g. If the document is being viewed by someone while you are in it, you can see who they are by clicking the 
other viewer(s) drop-down menu (in the upper-right corner of the document).
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Step 4: Close a Google document.

To close a Google document, move your cursor to the document name at the top of the screen and a left ar-
row will appear to the left of the name. Click that arrow to return to your Google Drive home page. The docu-
ment is automatically saved.

The new document will appear at the top of your documents list under My Drive.

Step 5: Additional Information

Google has developed apps for PCs and Smart phones. For more information about Google Drive, go to 
http://drive.google.com. YouTube is also a viable source of Google Drive tutorials.

Part 3: Explore Conferencing and Web Meetings
Web meetings combine fi le and presentation sharing with voice, video, and desktop sharing. Cisco WebEx 
Meeting Center is one of the leading web meeting products available today.

In Part 3 of this lab, you will watch a video produced by Cisco that reviews the features contained within 
WebEx Meeting Center. The video is located on YouTube at the following link: http://www.youtube.com/
watch?v=fyaWHEF_aWg

Instructor Note: For additional WebEx conferencing tools, you can register for a free WebEx Meeting Basics 
account at www.webex.com.
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Part 4: Create Wiki Pages
“Wiki” is a Hawaiian-language word that means fast. In networking terms, a wiki is a web-based collabora-
tion tool that permits almost anyone to immediately post information, fi les, or graphics to a common site for 
other users to read and modify. A wiki provides access to a home page that has a search tool to assist you in 
locating the articles that interest you. A wiki can be installed for the Internet community or behind a corporate 
fi rewall for employee use. The user not only reads wiki contents, but also participates by creating content 
within a web browser.

Although many different wiki servers are available, the following common features have been formalized into 
every wiki:

• Any web browser can be used to view or edit pages or create new content.

• Edit and auto links are available to edit a page and automatically link pages. Text formatting is similar to 
creating an email.

• A search engine is used for quick content location.

• Access control can be set by the topic creator, defi ning who is permitted to edit content.

• A wiki is a grouping of web pages with different collaboration groups.

In this part of the lab, you will use the Google account that you created in Part 2 and create a wiki page in 
Google Sites.

Step 1: Sign in to Google Sites.

Go to http://sites.google.com and sign in using the Google account that you created in Part 2 of this lab.
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Step 2: Click CREATE.

Step 3: Name your new wiki site.
In the Name your site fi eld, type in a name for your new wiki site. You will need to come up with a unique 
name for your site that has not been used by any other Google user. Google also requires that you enter the 
code (displayed at the bottom of the screen) to prevent automated scripts, called web robots, from creating 
multiple sites. After you have entered your site name, click the CREATE button. If someone has used your 
site name already, you are prompted to enter another name.
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Step 4: Edit the look of your new wiki site.

a. Google has provided templates for you to change the look of your new wiki site. Click the More drop-
down menu, and then click Manage site.

b. Click Themes at the bottom of the left sidebar.
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c. Select a theme that appeals to you and click SAVE.

d. After you have saved your theme selection, click your site name under Manage Site.
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Step 5: Update the Home page.

a. The Home page is the fi rst page that everyone sees when they come to your wiki site. You can edit the 
content of this page by clicking the edit button. From here, you can add text, pictures, or anything else to 
show on this page.

 

b. Click Save after you make your changes. This takes you out of page edit mode.

Step 6: Create a wiki page.

a. To create a new page that you and your visitors can use to make posts, click the new page icon.

01_9781587133138_ch01.indd   13 7/10/13   1:43 PM



Chapter 1 — Exploring the Network14

b. In the Name your page fi eld, enter a page name. In the example below, the name Routers is used as the 
topic for this page.

c. Click the Web Page drop-down menu and select Announcements. Google uses this term to indicate a 
wiki page.

d. Click CREATE to create your new wiki page.
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e. Your new wiki page, called Routers, displays and has a New post menu option that allows information to 
be added to the page. (Notice that the left sidebar has a new link to allow your site visitors access to this 
page.)

Step 7: Share your web site.

A wiki site is not really a wiki site unless other people can contribute. There are a number of ways to share 
your new site. In this example, we will show you how to share your site to designated people who have Gmail 
accounts.

a. On your wiki site, click Share.

b. Add a name, email address, or group who you grant access to this site.
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c. As soon as you start entering information into the Add people box, the box provides more options. The 
Can edit drop-down menu allows you to choose the document privileges (Can edit, Can comment, Can 
view) for the people you add. You can also specify how to notify these people of this document (Send a 
copy to myself or Paste the item itself into the email). Click Share & save.

d. Click Share & save to save your sharing settings.

e. The Manage Site page displays the people who have access to your site. Click your site name to return 
to your home page.
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Step 8: Provide the URL of your site.

You can provide your URL to your new site by adding your site name to the end of the Google site URL, as 
shown here: http://sites.google.com/site/(sitename).

Step 9: Find additional information.

You can fi nd a quick overview of how a wiki works at http://www.youtube.com/watch?v=-dnL00TdmLY.

Other examples of wikis and their web sites include:

• Wikipedia — http://www.wikipedia.org/

• Atlassian Confl uence (a popular business wiki) — http://www.atlassian.com/software/confl uence/

• Wikispaces (another free wiki) — http://www.wikispaces.com/

Refl ection

1. Can you think of other collaboration tools used in the business world today?

_______________________________________________________________________________________

Answers will vary.

2. What collaboration tools do you see as useful to a network administrator?

_______________________________________________________________________________________

Answers will vary.
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1.2.1.3 Lab — Researching Converged Network Services 

Instructor Note: Red font color indicates text that appears in the instructor copy only.

Objectives

Part 1: Survey Your Understanding of Convergence

Part 2: Research ISPs Offering Converged Services

Part 3: Research Local ISPs Offering Converged Services

Part 4: Select Best Local ISP Converged Service

Part 5: Research Local Company or Public Institution Using Convergence Technologies

Background / Scenario

Convergence in the context of networking is a term used to describe the process of combining voice, video, 
and data communications over a common network infrastructure. Converged networks have existed for some 
time, but were only feasible in large enterprise organizations because of the network infrastructure require-
ments and complex management required to make them work seamlessly. Technology advances have made 
convergence readily available to large, medium, and small businesses, as well as for the home consumer.

In Part 1, you will describe your current understanding of convergence and any experience you have with it.

In Part 2, you will research which providers have this service, regardless of geographical location, using the 
predefi ned form included in the lab.

In Part 3, you will research which local ISPs in your area offer converged services for end-user consumers, 
using the predefi ned form included in the lab.

In Part 4, you will select the ISP you like best for home use and list the reasons why.

In Part 5, you will fi nd a local company or public institution using convergence technologies in their business, 
using the predefi ned form included in the lab.

Required Resources

Device with Internet access

Part 1: Survey Your Understanding on Convergence
Instructor Note: In Part 1, the instructor may wish to lead a discussion with students on their understanding 
of convergence, its defi nition and the possible technologies used. This lab may be assigned as homework.
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Step 1: Describe convergence as you understand it and give examples of its use in the home.

Write a defi nition of convergence and list some examples.

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

Convergence - Converged networks are capable of delivering voice, video streams, text, and graphics 
between many different types of devices over the same communication channel and network structure. On 
a converged network, there are still many points of contact and many specialized devices such as personal 
computers, phones, TVs, and tablet computers, but there is one common network infrastructure. An example 
of a converged network at home is a Triple Play service from Charter.com. Voice, Video (TV) and phone are 
bundled together and come into the home on one cable, typically hybrid fi ber coax.

Part 2: Research ISPs Offering Converged Services
In Part 2, you research and fi nd two or three ISPs who offer converged services for the home, regardless of 
geographical location.

Step 1: Research various ISPs that offer converged services.

List some of the ISPs that you found in your search.

_____________________________________________________________________________________

Comcast

Charter

AT&T

Step 2: Fill in the following form for the ISPs selected.

Internet Service Provider Product Name of Converged Service 
Comcast Xfi nity Triple Play

Time Warner Cable TV, Internet,and Phone

AT&T AT&T U-verse

Part 3: Researching Local ISPs Offering Converged Services
In Part 3, you research and fi nd two or three local ISPs who offer converged services for the home in your 
geographic area.
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Step 1: Research various ISPs that offer converged services.

List some of the ISPs that you found in your search.

____________________________________________________________________________________

Answers will vary based on geographic location.

Step 2: Fill in the following form for the ISPs selected.

Internet Service Provider Product Name of Converged Service Cost per Month Download Speed
Comcast Xfi nity Triple Play $89.99 Varies 10 to 16 Mbps 

Time Warner Cable TV, Internet,and Phone $99.99 10 Mbps 

AT&T U-Verse $59.00  3Mbps Download

Part 4: Select Best Local ISP Converged Service Offering
Select your top choice from the list of local ISPs that you selected and give reasons why you chose that par-
ticular one.

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

Answers will vary and will be typically based on price per month and relative priority of Internet speeds versus 
number of TV channels offered in the basic packages. Student may choose Comcast for higher download 
speeds for Internet. Emphasize to students that home users’ priorities can affect their choice of service. For 
example, users who stream movies exclusively may want higher download speeds versus a user who mainly 
does casual surfi ng of the Internet and checks email.

Part 5: Research Local Company or Public Institution Using Convergence 
Technologies

In Part 5, you research and locate a company in your area that currently uses convergence technologies in 
their business.

Step 1: Research and fi nd a local company using convergence.

In the following table, list the company, industry, and convergence technologies used.

Name of Company Industry Convergence Technologies
Cisco Systems, Inc. Information Technology Phone, Video, Data

Woodward, Inc. Aerospace Phone, Video, Data
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Refl ection
1. What are some of the advantages of using convergence technologies?

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

Blending voice, video and data signals onto one communication infrastructure allows companies to better 
manage the technology since the network will use a common set of rules and standards. The need for sepa-
rate distribution equipment for offering voice and data will no longer be necessary.

2. What are some of the disadvantages of using convergence technologies?

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

Until the technologies fully mature, confi guration and management of voice, video and data fl owing on one 
channel can be a challenge. Giving voice precedence over data using Quality of Service (QoS) technologies 
can be quite complex for companies that don’t have trained IT personnel on staff.
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1.3.3.3 Lab — Mapping the Internet 
Instructor Note: Red font color indicates text that appears in the instructor copy only.

Objectives

Part 1: Test Network Connectivity Using Ping

Part 2: Trace a Route to a Remote Server Using Windows Tracert

Part 3: Trace a Route to a Remote Server Using Web-Based and Software Tools

Part 4: Compare Traceroute Results

Background

Route tracing computer software is a utility that lists the networks data has to traverse from the user’s origi-
nating end device to a distant destination network.

This network tool is typically executed at the command line as:

tracert <destination network name or end device address>
(Microsoft Windows systems)

or

traceroute <destination network name or end device address>
(Unix and similar systems)

Route tracing utilities allow a user to determine the path or routes as well as the delay across an IP network. 
Several tools exist to perform this function.

The traceroute (or tracert) tool is often used for network troubleshooting. By showing a list of routers tra-
versed, it allows the user to identify the path taken to reach a particular destination on the network or across 
internetworks. Each router represents a point where one network connects to another network and through 
which the data packet was forwarded. The number of routers is known as the number of “hops” the data trav-
eled from source to destination.

The displayed list can help identify data fl ow problems when trying to access a service such as a website. It 
can also be useful when performing tasks such as downloading data. If there are multiple websites (mirrors) 
available for the same data fi le, one can trace each mirror to get a good idea of which mirror would be the 
fastest to use.

Two trace routes between the same source and destination conducted some time apart may produce different 
results. This is due to the “meshed” nature of the interconnected networks that comprise the Internet and the 
Internet Protocols ability to select different pathways over which to send packets.

Command-line-based route tracing tools are usually embedded with the operating system of the end device.

Other tools, such as VisualRoute™, are proprietary programs that provide extra information. VisualRoute 
uses available online information to graphically display the route.

This lab assumes the installation of VisualRoute. If the computer you are using does not have VisualRoute 
installed, you can download the program using the following link:

http://www.visualroute.com/download.html
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If you have any trouble downloading or installing VisualRoute, ask your instructor for assistance. Ensure that 
you download the Lite Edition.

Scenario

Using an Internet connection, you will use three route tracing utilities to examine the Internet pathway to 
destination networks. This activity should be performed on a computer that has Internet access and access to 
the command line. First, you will use the Windows embedded tracert utility. Second, you will use a web-based 
traceroute tool (http://www.subnetonline.com/pages/network-tools/online-traceroute.php). Finally, you will use 
the VisualRoute traceroute program.

Instructor Note: Many schools do not have access to the command prompt. Traceroutes are included in 
Apthis activity, make sure there are no local restrictions related to ICMP datagrams. This activity assumes that 
ICMP datagrams are not restricted by any local security policy.

Required Resources

1 PC (Windows 7, Vista, or XP with Internet access)

Part 1: Test Network Connectivity Using Ping

Step 1: Determine whether the remote server is reachable.

To trace the route to a distant network, the PC used must have a working connection to the Internet.

a. The fi rst tool we will use is ping. Ping is a tool used to test whether a host is reachable. Packets of infor-
mation are sent to the remote host with instructions to reply. Your local PC measures whether a response 
is received to each packet, and how long it takes for those packets to cross the network. The name ping 
comes from active sonar technology in which a pulse of sound is sent underwater and bounced off of ter-
rain or other ships.

b. From your PC, cl ick the Windows Start icon, type cmd in the Search programs and fi les box, and then 
press Enter.

c. At the command-line prompt, type ping www.cisco.com.
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d. The fi rst output line displays the Fully Qualifi ed Domain Name (FQDN) e144.dscb.akamaiedge.net. 
This is followed by the IP address 23.1.48.170. Cisco hosts the same web content on different servers 
throughout the world (known as mirrors). Therefore, depending upon where you are geographically, the 
FQDN and the IP address will be different.

e. From this portion of the output:

Four pings were sent and a reply was received from each ping. Because each ping was responded to, 
there was 0% packet loss. On average, it took 54 ms (54 milliseconds) for the packets to cross the net-
work. A millisecond is 1/1,000th of a second.

Instructor Note: If the fi rst ICMP packet times out, this could be a result of the PC resolving the destina-
tion address. This should not occur if you repeat the ping as the address is now cached.

Streaming video and online games are two applications that suffer when there is packet loss, or a slow 
network connection. A more accurate determination of an Internet connection speed can be determined 
by sending 100 pings, instead of the default 4. Here is how to do that:

And here is what the output from that looks like:

f. Now ping Regional Internet Registry (RIR) websites located in different parts of the world:

For Africa:

C:\> ping www.afrinic.net
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For Australia:

C:\> ping www.apnic.net

For Europe:

C:\> ping www.ripe.net

For South America:

C:\> ping lacnic.net
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All these pings were run from a computer located in the U.S. What happens to the average ping time in 
milliseconds when data is traveling within the same continent (North America) as compared to data from 
North America traveling to different continents?

____________________________________________________________________________________

Answer varies based on location. In the data above, the average ping time in milliseconds dramatically 
increases.

What is interesting about the pings that were sent to the European website?

____________________________________________________________________________________

At the time that these pings were sent, the site was unreachable.

Part 2: Trace a Route to a Remote Server Using Tracert

Step 1: Determine what route across the Internet traffi c takes to the remote server.

Now that basic reachability has been verifi ed by using the ping tool, it is helpful to look more closely at each 
network segment that is crossed. To do this, the tracert tool will be used.

a. At the command-line prompt, type tracert www.cisco.com.

b. Save the tracert output in a text fi le as follows:
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Right-click the title bar of the Command Prompt window and choose Edit > Select All.

Right-click the title bar of the Command Prompt window again and choose Edit > Copy.

Open the Windows Notepad program: Windows Start icon > All Programs > Accessories > Notepad.

To paste the output into Notepad, choose Edit > Paste.

Choose File > Save As and save the Notepad fi le to your desktop as tracert1.txt.

c. Run tracert for each destination website and save the output in sequentially numbered fi les.

C:\> tracert www.afrinic.net
C:\> tracert www.lacnic.net

d. Interpreting tracert outputs.

Routes traced can go through many hops and a number of different Internet Service Providers (ISPs), 
depending on the size of your ISP and the location of the source and destination hosts. Each “hop” repre-
sents a router. A router is a specialized type of computer used to direct traffi c across the Internet. Imagine 
taking an automobile trip across several countries using many highways. At different points in the trip you 
come to a fork in the road in which you have the option to select from several different highways. Now 
further imagine that there is a device at each fork in the road that directs you to take the correct highway 
to your fi nal destination. That is what a router does for packets on a network.

Because computers talk in numbers, rather than words, routers are uniquely identifi ed using IP addresses 
(numbers with the format x.x.x.x). The tracert tool shows you what path through the network a packet of 
information takes to reach its fi nal destination. The tracert tool also gives you an idea of how fast traffi c is 
going on each segment of the network. Three packets are sent to each router in the path, and the return 
time is measured in milliseconds. Now use this information to analyze the tracert results to www.cisco.
com. Below is the entire traceroute:

Below is the breakdown:
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In the example output shown above, the tracert packets travel from the source PC to the local router de-
fault gateway (hop 1: 192.168.1.1) to the ISPs Point of Presence (POP) router (hop 2: 10.18.20.1). Every 
ISP has numerous POP routers. These POP routers are at the edge of the ISP’s network and are the 
means by which customers connect to the Internet. The packets travel along the Verizon network for two 
hops and then jump to a router that belongs to alter.net. This could mean that the packets have traveled 
to another ISP. This is signifi cant because sometimes there is packet loss in the transition between ISPs, 
or sometimes one ISP is slower than another. How could we determine if alter.net is another ISP or the 
same ISP?

e. There is an Internet tool known as whois. The whois tool allows us to determine who owns a domain 
name. A web-based whois tool is found at http://whois.domaintools.com/. This domain is also owned by 
Verizon according to the web-based whois tool.

To summarize, Internet traffi c starts at a home PC and travels through the home router (hop 1). It then 
connects to the ISP and travels through its network (hops 2-7) until it arrives at the remote server (hop 8). 
This is a relatively unusual example in which there is only one ISP involved from start to fi nish. It is typical 
to have two or more ISP involved as displayed in the following examples.

f. Now examine an example that involves Internet traffi c crossing multiple ISPs. Below is the tracert for 
www.afrinic.net:
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What happens at hop 7? Is level3.net the same ISP as hops 2-6, or a different ISP? Use the whois tool to 
answer this question.

____________________________________________________________________________________

The Internet traffi c goes from being on alter.net to level3.net. The whois tool reveals that this is a separate 
company/separate ISP.

What happens in hop 10 to the amount of time it takes for a packet to travel between Washington D.C. 
and Paris, as compared with the earlier hops 1-9?

____________________________________________________________________________________

In hops 1-9 most packets traverse their link in 50 ms or less. On the Washington D.C. to Paris link, the 
time increases to 132 ms.

What happens in hop 18? Do a whois lookup on 168.209.201.74 using the whois tool. Who owns this 
network?

____________________________________________________________________________________
1.74) is owned by the African Network Information Center.
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g. Type tracert www.lacnic.net.

What happens in hop 7?

____________________________________________________________________________________

The time it takes for a packet to traverse the network dramatically increases over fourfold from ~40 ms 
to ~180 ms. Did students do a whois on registro.br using the web-based whois tool: http://whois.domain-
tools.com/. If they did, the information they received was not that helpful. Did your students go to: http://
translate.google.com/ to get a translation of Núcleo de Informação e Coordenação do Ponto? More help-
ful would have been a search engine request for “top domain .br” This would have revealed that we were 
now on a Brazilian network. Internet detective work can be fun!

Part 3: Trace a Route to a Remote Server Using Web-Based and Software-
Tools

Step 1: Use a web-based traceroute tool.
a. Using http://www.subnetonline.com/pages/network-tools/online-tracepath.php to trace the route to the fol-

lowing websites:

www.cisco.com

www.afrinic.net

Capture and save the output in Notepad.
www.cisco.com:

TracePath Output:

 1:  pera.subnetonline.com (141.138.203.105)                0.157ms pmtu 1500

 1:  gw-v130.xl-is.net (141.138.203.1)                      1.168ms

 2:  rt-eu01-v2.xl-is.net (79.170.92.19)                    0.566ms
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How is the traceroute different when going to www.cisco.com from the command prompt (see Part 1) 
rather than from the online website? (Your results may vary depending upon where you are located geo-
graphically, and which ISP is providing connectivity to your school.)

____________________________________________________________________________________

____________________________________________________________________________________

The tracert from the command prompt in Part 1 ended up at a server in Cambridge, Massachusetts. The 
traceroute from the website in the Netherlands went to a mirror server in the Netherlands. The domain 
cisco.com is hosted on many websites or mirrors throughout the world. This is done so that access time 
to the site will be fast from anywhere in the world.

Compare the tracert from Part 1 that goes to Africa with the tracert that goes to Africa from the web inter-
face. What difference do you notice?

____________________________________________________________________________________

____________________________________________________________________________________

The route across Europe is on a different ISP. Make the point with students that there is not a single back-
bone to the Internet. Rather there are many backbones to the Internet. They all connect at Peering Points. 
Performance on the network on one ISP could be very different than performance on the network with a 
different ISP.

Some of the traceroutes have the abbreviation asymm in them. Any guesses as to what this means? 
What is its signifi cance?

____________________________________________________________________________________

____________________________________________________________________________________

This is an abbreviation for asymmetric. It means that the test packet took one path to reach the destina-
tion, and a different path to return by. Imagine someone driving from their home to New York City. On 
the way to New York City, they noticed that the highway was congested and traffi c was slow. They might 
decide to come home by a different or asymmetric path.

Step 2: Use VisualRoute Lite Edition

VisualRoute is a proprietary traceroute program that can display the tracing path results graphically.

a. Please download the VisualRoute Lite Edition from the following link if it is not already installed:

http://www.visualroute.com/download.html

If you have any trouble downloading or installing VisualRoute, ask your instructor for assistance. Ensure 
that you download the Lite Edition.

b. Using VisualRoute 2010 Lite Edition, trace the routes to www.cisco.com.

c. Record the IP addresses in the path in Notepad.
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Part 4: Compare Traceroute Results
Compare the traceroute results to www.cisco.com from Parts 2 and 3.

Step 1: List the path to www.cisco.com using tracert.

23.1.144.170

Step 2: List the path to www.cisco.com using the web-based tool on subnetonline.com.

141.138.203.105 > 141.138.203.1 > 79.170.92.19 > 19.239.116.226

Step 3: List the path to www.cisco.com using VisualRoute Lite edition.

192.168.1.17 > 192.168.1.1 > 10.18.20.1 130.81.196.188 > 130.81.151.1 130.81.22.46 > 152.63.9.249 > 
152.63.17.109 > 152.63.21.14 > 231.144.170

Did all the traceroute utilities use the same paths to www.cisco.com? Why or Why not?

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________
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Refl ection

Having now viewed traceroute through three different tools (tracert, web interface, and VisualRoute), are there 
any insights that using VisualRoute provided that the other two tools did not?

_______________________________________________________________________________________

_______________________________________________________________________________________

_______________________________________________________________________________________

Answers
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1.4.3.6 Lab — Researching IT and Networking Job Opportunities 
Instructor Note: Red font color indicates text that appears in the instructor copy only.

Objectives

Part 1: Research Job Opportunities

• Identify the current networking jobs that are in demand.

• Explain the value of Cisco certifi cations in the job market.

Part 2: Refl ect on Research

• Identify current hiring trends in IT/networking.

• Identify future networking career certifi cations and skills.

• Identify additional networking career paths.

Background / Scenario

Jobs in Information Technology (IT) and computer networking continue to grow. Most employers require some 
form of industry standard certifi cation, degree, or other qualifi cations from their potential employees, especial-
ly those with limited experience. The Cisco CCNA certifi cation is a known and established entry level network-
ing certifi cation that is respected in the industry. There are additional levels and kinds of Cisco certifi cations 
that one can attain, and each certifi cation may enhance employment opportunities as well as salary range.

In this lab, you will do some targeted job searching on the web, to fi nd what types of IT and computer net-
working jobs are available; what kinds of skills and certifi cations you will need; and the salary ranges associ-
ated with the various job titles.

Required Resources
• Device with Internet access

Part 1: Research Job Opportunities
In Part 1, you will use a web browser to visit the popular job listing web sites monster.com and salary.com.

Step 1: Open a web browser and go to a job listing website.

In the URL address bar type in http://monster.com and press Enter.

Note: For job listings outside of the US, use the following link to search for your country:

http://www.monster.com/geo/siteselection/

Step 2: Search for networking related jobs.

a. Type the word Network in the Job title box. Notice that the website offers context sensitive suggestions 
based on the keywords provided. Either click on, or fi nish typing the words, Network Administrator and 
click the SEARCH button (see image below).
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b. Notice the search results:
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c. Now focus your search by adding terms to the keywords fi eld box. Try terms like Cisco CCNA, CCNP, 
CCNA Security, CCNA Voice, etc.

d. Now try refi ning your search by adding in different geographical locations. Did you fi nd jobs in the loca-
tions you entered?

____________________________________________________________________________________

Answers will vary.

e. Try searching a different website. Go to http://salary.com and click the Job Search menu bar button.

Note: For salary listings outside of the US, use the following link to search for your country:

http://www.payscale.com/rccountries.aspx
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f. Now add a search term like Information Technology to the job title fi eld box and click Submit.

g. In the image below, note the large number of matching search results. There are also easy to use tools 
for refi ning your search, in the column to the left.
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h. Spend some time searching for jobs and looking through the search results. Take note of what skills are 
required for different job titles and the range of starting salaries.

Part 2: Refl ect on Research
In Part 2, you answer questions based on your research fi ndings.

a. What job titles did you search for?

____________________________________________________________________________________

____________________________________________________________________________________

b. What skills or certifi cations were required?

____________________________________________________________________________________

____________________________________________________________________________________

c. Did you fi nd any jobs that you previously did not know existed? If so, what were they?

____________________________________________________________________________________

____________________________________________________________________________________

d. Did you fi nd any jobs that you are interested in? If so, which ones and what skills or certifi cations do they 
require?

____________________________________________________________________________________

____________________________________________________________________________________

____________________________________________________________________________________
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1.5.1.1 Class Activity — Draw Your Concept of the Internet Now 

Instructor Note: Red font color indicates text that appears in the instructor copy only.

Objectives

Identify the common components of a network.

In this activity, you will illustrate how concepts from Chapter 1 are applied to show how network devices con-
nect to and throughout the Internet. After refl ecting on your home or small-business topology, you will become 
familiar with using the device icons and knowledge needed to visualize network connectivity through the 
remaining network courses.

Background / Scenario

In this activity, you will use the knowledge you have acquired throughout Chapter 1, and the modeling activity 
document that you prepared at the beginning of this chapter.  You may also refer to the other activities com-
pleted in this chapter, including Packet Tracer activities.

Draw a map of the Internet as you see it now.  Use the icons presented in the chapter for media, end devices, 
and intermediary devices.

In your revised drawing, you may want  to include some of the following:

• WANs  

• LANs

• Cloud computing

• Internet Service Providers (tiers)

Save your drawing in hard-copy format. If it is an electronic document, save it to a server location provided by 
your instructor. Be prepared to share and explain your revised work in class. 

Instructor Note:  This Modeling Activity may be selected as a graded assignment, because its purpose is to)

Required Resources
• Beginning of chapter modeling activity drawing

• Packet Tracer (may be optional if students sketch their own drawing)

• Paper and pencils or pens

Refl ection

1. After completing Chapter 1, are you more aware of the devices, cabling, and physical components of a small-
to-medium size network?  Explain your answer.

_______________________________________________________________________________________

(Answers will vary per student – but this refl ection question will generate some good class discussion and 
foster community between students and the Instructor)
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Modeling Activity Graphic Representation (designs will vary) 

Instructor Note: This is a representative model that might be “built” as a result of this activity.

Iden  fy elements of the model that map to IT-related content: 

• Devices/Equipment

• Media (cabling)

• Social Media Links

• Sources & Destinations

• Local Area Networks

• Wide Area Networks
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